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DR > B EERR— AN B GHBETE
MOREIRE b » BRBLD TR — ANAERME
REM > MZTR FROM - BEXR Data
East AFRACapcom AFMERK » 4 BB
ZI ) %R H Apple [e  IBM PCRKCe4=#
WA b o 0 58 2 HUR A9 90 5% F5E A0 9 o
fEftZH » Data East ARRGEREM [ R
#ilfE | ( Kung Fu Master ) %% Apple
I L BERERTE » FAURZHT o MSHA
FIBMTERGR » FEWRER LR [ B
#£4 | ( Tag Team Wrestling ) %% Apple
IE» HURERHAERYER » HEORK o B
ROEN T RBZI | ARW » & LTES
BB |

o MRt
[Apple]

@® Apple Je, Jc128 KXo
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1R 5 HESR » AWA FHEM o
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A%

- /RTE

2 2t Iy, 2 F
2 g AL ) A5

B—) iR ERYBPAT LR o

B~ RKAER - M/RPRAFBRBFRRE LR

ABTITHERAGKY  HE— I HA5
$2 R 2P BB ERFR s HE T eeeeeeens

e LM [ RARAEAE ) 1S ARy (k)
L AT KR A SR AR AL D AU M TS 1 ) 48

(LA Sy = |

T T g /| vl 4 : 1 AE e
WGt MR I Y W —AE [ 3l '\F:'-'_,' i)

BEUE2EMGEHEET » HEASEERMLEL

BRI » For 9% [ HSlARE ) A A R RIALEE

o [ B9 FHRREE) » A THRECH

RSB 2 5y 0 |
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15+ H 8% ( The Scene Designer Menus)
R 5 B A T A T T 4 5 A M A
R RS O RB— B ATBOBHER - T
RCTRS MM » ERAFANBABH &
2 i MR EFE— T WK ) (Sc-
e ) ?

BRALE QS TEHEBHBAY - Wik~ LFW
o -F il o (ESPEEIIR AT » BN N o
AS (i SR RARRE R EE )
EAWRES - HERAERT » A—REPY
A 0 7 9 S 28 8 S e S 5 LA o
{9 B T e [kl ASE ) ( Animate)
« [ <% | ( Dazzle Draw ) ~ LR
b M R TR A EERA o
— R TR REOFT AR ® o BB RE

BE R » WEIRONERS 0 FRADR
EP KT RN BB o BAEBIRE—REY
S B+ (H S A AT /I D 28 2 R ) A
S5t T R AT ) AR TR D) REW
PHEE > EERLBRAVNDENEE > &
FEUE B |- 77 BB R o

RE(7628A)

& A PEmR BB EER  NREE—BHR AWEN

3 4 MW ( Main Character Screen) : i AH)
MUHERBH ERAARN  FUEDEERBHUN
fE—MRE BRI o

(DA% M ( Characters ) : ER MR AN A
AEHERFRMERTRRATRANDEA®D
420 ( —RELTRATAHEDEAD ; RBLIA
MBS+ AERTREN) » REETRHAY
i BT A BUREFT A RWER » FERNA
Il oD A 4 i 21088 W) O B RS I A R IR B4
M B ) sHED T BB A o

3=t B < . 0 O O 0 4T A v e B 1 SR o
SGE B AR B AR R 8.1 EAMA

[ (e [TserE] it
T

Characters:

I EABRE

4 >

B i & 1 Zi- m_yﬂ

EExafe

da
— BUE 8 P

(2)F fa i< ( Character Display) : BU/RER
BEBOBMEE » & FBEFER B PTER R
m R 3 1 T 5 o e 6Lt S JE L % 0 3 B il 9 O
B o

@QME ( Frame ) : Br7/RAVINEE IR B 8l AT R
oM AT DUGE A AR A a0 R IR - o F GO R
BE “Frame " @RGP # | SR A M
MATEIEE o IR ASREE T (ESC) 8 RIS 08 A0 R
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SRR » 25 9% 4 0 SRS 7 A
Vi B - WL~ T 89 37 BSE 6] 3: 7
B o
(TR ( Total ) @ RREBIMFABMAY
MR o
OB ( Priority ) @ RESHMADILB%E
MU » WAL 13 60 BRI FY o
R “Priority " # » MW E— Wil RIE
RERIBFE » —A0 WA DR R B0
B o
O ( Go ) @ 4 “Gd” Fkeh [ # | SR H6%
IR TUE RV — K o WHRBHEATRE » AT S
T 45 5 88 R R,

@z ( Space Bar ) : ¥ o

@F : M AT (AN B LB by

BT ) ©

O : MR

@ B WHE K o

® B0 PR IR B A AR o

0 b I A B R R R AR T o
(M [E]1F: /4% A ( Restore Main Character Scr-
cen ) : HEUSIR{G RS0 B T AF RS AR
W AR R AR k) SHERE R
FARH o
(52 5% H & ( The Crown Menu) : AHFRE
9% B BRI -4 Wik B 53t 2 ( Graphic
Designer ) thiyCs2 % F Sk BRI » MBHM
iR o
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R B8k ( The File Menu) : KHS#BEMI)
BE RS LU (8 9 FOR A BURE) A9 ~ IR RBIR -
[y th G 77 800 » 55 038 G T BAFRURRE A )
IHHE » BB R R\ R AR e [l KA ) 8T
EBEBAT o

|t s3m

Load T} A
[ Save Scene] ]

Disk]] sufrmmas

R ESPOE IR R FIAE [ }EER ) ( Diay
logue Box) SR A&l » 335K 6k AAIBRFE
(MH4%) » BT HEER » REFRAM AR
B BN — Gy > [ -FBAR | &5
REEERBH o
(DA ( Load ) : AIYEERBNFR » @4
W HEAHAMT :

O % B #RMMA ( Load ) T o

Q@BEBEBATORWBERAY ~ WHRABRK

@ HER | T &Fn—a MM E &

R TR & MR AAY 7R R
7 ( Get Character or Backgrond or Sc
named ) o

OBBHWHWMEIROLM L[ # | 51> B

MY EBFRE LAWY o

®F “Okay " L[ # | SHREE » BeAEDBM

WERAHMOWRIBRELIETRE [k
KHD ) 63 (G 38 3% B 0 2 A AR 5 AR B A
BAHUNERN LSRG EG » B4 %R
BADERABIL » LAWK ISR R R R



.03d Backgreund samed: OTY.RIGHT
Prefiv: SEXGND.LIDRARY/
“rafix Oirectory conteing:

ASTEROD

. L N L RS
REE

STRGE
JUTODDORS

Lﬁﬂﬁk&ﬁ‘ﬁh

" BT ) SREPT o

T AR ( Save Scene ) [ ADERHEE T

BESRDRTFERERA L PR T -
DEE A SRR FEIRIHE -

2 HER | BVR—HRHEMTER A E & » [ &
HIAm® WG 8R4 # ( Save Scene
named ) o

DRARAN HHGA WES ) B&RPEFR
» ARG ERB B L [ # | spepaf o

@FE “Okay” L[ 1% | SHBETE o

SR AT 17 35 SR TR R L A8 50 6 o 7 i 18 1

SILEEA » [RACKED ) R BBt BT SR

TR B TFAKBEEE R REA A
W ESTR o
BRIOBE © ATHEEAYGE A 5 vk B [ AR Gt b AT ik
8 1F B ek IHiE : AKZHREAVEE A J5 ok B B % i op

F@HE o

SR AL - ART)BERYGE 05 2 SR R SR P A

-. a0

B FR ) ( Make Show Disk ) : BAS

EORAYLBTHRDBORATRE A « X

BREEER 526 N » mifARS Rl

“Cancel

BEgiE(7628A)

Aah J FREE e BREARME o [ 8KE J i
AR ( Demostration Disk ) gf & A Lh
BERTRUFAY R "R F o BUPESRRIF ¢
OHIHEE H &R NAE R A IIE o
QEBMIEREHMA BARBER G o
@7 “Okay” | [k | SHIERE o
—HMESE R » BEH BB A — 3550 Bl B v i %
WRABE o BAERRAREFZSIRAZHNE » o Bl
FIEB R AN FEERARA (G FENS R
BEHNRRBIREE s ADAHE T RME ) o
W R SERLE » v S EDN [l KA ) 36
A B/ A DB RICOR » B RF A R Y A K
AE R IR 5 3 SR W) W Y R W Y » AEE 06 ]
{8 T 2 (v T e S 2 i 9 i ) BOR -
e 205§k ( Space bar ) : Wi
o382 : Hn
o[ : i
e |RETURN| £ : i #7di
o [TAB] & : Bkdi F—#5%
o |ESC| 8 © ¥ 153 H 36 o] ) 85 5% WU i 8 R




(WL Bk ( The Tools Menu ) : AN H &
TEMRESHRAWEBRBBMS X » 7 LIH
BRI (RER ) FIERADHBBHEE » o]
15 1077 6N WS B > Bl R R A
HEBBAY » BOEEETHS > BREBHRA
WHR T BEM B MR X B E) » TRHS
Fe i —BUZH RERS W pla SR 0 (R ARt AR X o
(D% REHKE ( Set Path Directly ) : K2y
TERBEBBMA Y BB BB E HHHR o 3t
BAEHRMT
OHHER B SR MR AZHHE » LMK
WA o
@WEIFEATAE &

RSB o
@ T ke 0 i @ B 8 fE o
@ () it 3 76 % i S

% » FROAD

B BT 37 5 T 2
B » BRI R QRN

(DAY B B R 7B R ES o

(M HSRAK » [F R 6 R B8 5 B ) »
IG5 B 8 B B U L
o MR MRS > RIEM A BB LRHAB
B o

@FERBEH » WK T [ESC| RLIREERIR

SE o JI7NiM R A TR BT 7 AR BR AR » U T $2{ DY

> DUDUT 81 18 BT B E RO BE R o
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SR 2(a) U 3 B DR 4 SR B E (BRI > AR
R ME RIS [ K05 | —B% > HERF
\Vorwm 5] sonsmi—B
bi#n A 3t A% ( Additional Charact-
ers ) : BRPKMAES AR » ££
MR —HBAY % > BHRIRHIH
WML > FETRESATHERE
» — R % WS ) AR RS
B — W o
(2513 EHE ( Set Path by Leading ) : &
DIENRBEADWERBEEERNEBBIEEA
o HBEHRMT :
OHHER B SRR A )L WA — @2 EE)
BAY o
Q@i EARHMAY 2 M chHR — 8 LUETRE
B o
QU T A HS&-hRWS (MR EMRLIIHE o
(D(a) [ HER | HAKGERZEBHHL > 8
WiESHE0 AT P R ST “Okay
" BT ) SHEEE -

oo 3

LA BEBBRE -




(b) A5 S5t M 66 » |- SRS AY D WA 0 @ 1
BIfEIEchoe » 55058 45 — (AT SRV R R 3L
1E 5 (0/Jn g5 o BT SR /1N ) o 5 I 2 7
o i 9 T
(C) B8 A M3 5 8 A o 1 62 > IR WM R R
RBEBWHER » Wi FRY ARRSGEA
, PBE
(AP I RN RRPLHRRIAD R
? [5E ) FERE S0 I » 4538 H0 R A SR B B 3t
TN 8 3 (RS M 07 o
(@)ME T SR/ B » HIRLE) A B BEDALA B 771
[ (@) T ¢ 2 S 16 G S U B RS D » [ 3R
PRAAEC Sk A D BB B BR AR » U O HES 5 A
— G Ik o
| ORERE R % [ESC MU R
S BERCEEI AR » IR b AR
W AT #5F [DEL] 83 5 v B 5B 621
ot o
B ERE® ( Set Path With Keyboard ) :
EIHBER G T BB EAYBREN S AR DA
036 B BB DA S 7R R T A A PR o
HEDVEME .
DR H Shch SR A ZHHE 3 WA — 8 5 58
BMAY o
DmEARBMAYL Nich iR —@ » DIRER
BRI o
@ T H #keh RIS E R I RE » i
AR R b > WA & HBEE bR
i o
@) il AL R TSRS AYB %
KB i o
(b)s 3 45 4% — T 72 Fa 8 A % 0 B0 T — 45 o
(C)AC 45 {66 FR 7 4 Al S 80 6 e A\ 0 DAL 0 3 o BB

v i e

=

MRS (76428A)

(ct) T #82 (b) 2% (C) ¥ 5] %65 (18 Bt 8 ARG S K o
®#% T [ESC] & U7 i i i fro B 68 3 3 e 3:
AR o 3 b T A E A B AR R o Bl AT
#F [DEL] # » 6 e ek GUK i
i o
(4)i(E] M % it #2 X ( Graphic Designer ) @ K
L)y 1 398 98 W 40 ) O e 0 K DL
0 B0 1 A 9 B S A o
copylliii

I
IDelete]|[]]

(H#RHEt E & ( The Edit Menu ) : A& H&nu5ik
72 W] i 2 B 0 s Ol i rRAVGEER » th T DU Scaich
SEENNERXF s ADHBFEFH - EEW
F LA B85 S ch 0 B8 > #EDSEEE I B — IR
v B U 8 A A\ B 55 45 A BR o
(D#E ( Move ) : AKBIZHRE ] #é— HBTAOME
BASNADBHNREEDSRPREMNR ) HRB
WRMT .

Ol A HSpRI|E EERETHIE » XRE

— A BB o
QI H SR RIRE IHHE -
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@— I i & | B MR IGRIE B I H 2
i~ AW SR o

Move frames. v Cancel

@HEWER B ERAE T “From” LT 180 o
®%#]| “Frame ” Jifgeh [ 4% | SRAAGRBA #
T o th ] 6 S SO SR ) i T RS
REHS o
©FRH UM “Thru " k% )81 FKP
LGRS ] 8
@i tAE “To " LT # ) SCKH HEEM K
T o
@EREAE “Okay " | [ # | S#EE » B
From” &% hru " ERRE G EEE
“To " FHREMMLI » LT 76 s i) i
HETHI (9999 TAF
@MURAES SIS » W HEUEERS B
LS “Cancel ” LT # | $HIUA o
(8L ( Copy ) : AZhREW il LIBIBE — H B
Wi ~ AP~ BT ARSI o St REm
i
OB T AL H ShehsRRi 5 R E B I » XRE
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—BRADHBBHEE
@i T HE R IB B B IHBE ©
@— [ S ) HH B3 68 i 2 RS 4% B8 B A TR
ARME ~ AWSFEL > REs Wl &
“Okay ” k[ # ) sitiEsE ( BMADRER
BB BRI ) o

LA BRI -

@GRS ERAEEIRN “From” F LM% )
SIHRIE o
®#BE “Frame " k[ |6 EXTRA
WP B B SR W i o
©#FKAE “Thru " ¢ L[ # | $HRE » AL HH
BRI MW
@fctete “To " F k[ # ) $15%R%E » XL HWBHY
HEORBMEY
@7 “Okay " L[ # | §H#EE » Al “From
" % “Thru ” ILAFTA B HE R > X
H#AE “To” WM HHB o
@ $ LS BEBRAWI » QW7 “ Cancel
" BT % S o
()HBR ( Delete ) : ALfignl A RBHBAY
> B SRR — BT PR




DAE T L B kb 49 0 52 2 e BE e ZHBE » X aGE
—WMADNBBEEE -
@k SR SRR Z)BE o
@ — [ WAEE | A HI B » I 2R 58 P 2 1 B%: (1Y
WMEABME ~ AYalFa » F0E M ER— M
# » &£ “Okay " |HcSlHEE o
@B LR RSN “From” £ F[ # )
$IHRGE o
®OHBH “Frame " k[ # | #%E » X8
O\ 5l R R A 00 rvo iy 0 R i o R P
BriftinpyeEs o
@B “Thru " [ # | S WGP 5EG) LK
@FE “Okay " F [ # ) $HFEE » B “From
" #E “Thru " (kA0 G B ENER o
@WIRSE FIREREE AN » HIZE “"Cancel " L
[ % 1 $HAGH -
(Q)iBzBE 18 ( Clear Paths) @ A ZHfiE a6 it Br 83 it
AT ADNBBEEE o LRV HER !
D e #e 8t E & bR 19 0 B B IHE o
@— [ HAE A | BN LB BORE R LR ®
fEE » WEENTE “"Yes” T # #o
B)itiBi¥ it ( Clear BG ) : AIHHEA LU B ¥ it
BRMEERTR2E@ o JHEHPEME
O H S BRIy R IHEE -

@— [ HWEE | BHBYZREGHE GRS
BEE » BEERNE “Yes” [ )6e
@)ifBk —¥) ( Clear All) : AZHfiE w] it Br 18 5L
EiS AT AR E) A RS RO B R o B E

BT PPN G AR BTl s Y o (E H o JLAPREMI B ¢

B RE(7688A)

@ ey} 8 ch TR BR — G EHRE o
@— [ HWEG A ) HH B0 MORE W L IGRRE A
WEE » A FEERIAE “Yes” L& 15l o

[Gosdies|
Vi Galorifl
1L Stamp

Il
Remaue Text

ME 3 H# ( Goodies Menu ) | KH&KASE T
AT R ZHRE » wf A LLIM i 85 53¢ ©

(1)#i€s ( Color ) : ALhfEnl Bl /PR Hifa o FEGEA
R RAREE R BREA > ARy fE 8ROV RLE
BRI B (R LA R B A KTV B » R F
AIEH B & » thgtit s 6 ) hE & & 82 AP
B B SR BUR o BN S NS R (6 2) fE 6 I 1)
FATAUFE » B RZ8S SE HE Ry » LG A | R T
A o 7 “Color” “Fjiifi “v" BEXREEIHNE
EPHR ©
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(HELBA ( Stamp ) 1 ATHHE R W) WA B 1E T Ik
% L8 T BUAEES - LSRN T :
OHHE B PR MKA ( Load ) WEEYLKA
— A EAY o
@UREIEARBR » AW E HhHR—ADo
@HIE S B SR MBI > & “Stamp " F
WR V" BREEHEM -
@ TR B Seeh R B RERINRE o
ORETE&MEALBEAY » W EH R EH
1EF » BB oy B 080 4 S B R (075 S
E

@f K% [ =R e
@ FEEGEHREW “Stamp " — KA
ity “y" RIS » RRIRRL) HEE W
(FH ( Text ) : AR LUt BIRchigtE—
B0 SR B SR — Rt —
Wik > BIEMAEY 895 — 28 (Re-
more Text ) BIBR3C 74 o SUMHRMT :
1T S H ke R 52 RO B GE IO » 36 AE
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—ADBBHHBERE
@7 A MRS B WA > R

F

Hiy my name is
Dave and | love
to jog...

@HIE B kbR FREIDHE o
@BWHERBBIEITCFHSAL [ % 151> —0
PR H B ZRE W URAKLF

°

OB MTIR ST RATITLF » 52 #[ESC)
SEE AR o
@B T ( Remove Text ) © # MBI M
ERF R AR o AU :
OHES A bR TR » B WM
EXFo
@) 2 0 0 D O 9 T 1 B B
RGBT » SERE A B4 — A — AL L
T B o
O HEME SR WR L F I o
@ORBGKBMBRAOCTE [ # | SHREE » I
FRWL o
(G)ZIEHIEEHE € Print Screen ) : AI)fiEal j iR
e — MEFIE T o PR
AT SUE SRR MBS KT » WA
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2 [21]i0F U
@%RE — TR FIAM TN R IR & TR

a

@ e el1 119 B #0197V H) R M 2HRERD 7] HETT S
HIfY LIE °

- n.ﬂtil

Ji= |
1]
I:II'Ill.I'llllllllll|llllllllll
'rllllllll

'HEH’.III'H | U I A T

| 173
! SN *i¢l) .? _ J
| | - : - .

L Ex RIE

BEZ ( Sound ) : KI)fEa RFEADRBR
2o EMITH AN TR » BN o EN g
S — W AT S A ¥ A 4 R T B A 0 R [
WA o DA R A — W DUETTRCR
BROBRMFERMS o HKMHNERTREILES
SRR ARFEFTREHMEY ( Synch ) »
BTEEFE—-AN LTS BE— A E R
B AT R RRFHDRAHEMAAREE
Wit > R D MACRE » BREEHAE R
EBeE R o TS/ REE 2N

OHTAHSRMAEREHEALBNF—BR -
@4 I = 5 A R I O A e 8 D 1 R B ARG SR Y

s -
Q@hE S HEREFHYME » HEHRBRTRS

W M(7688A)

A7 — SN SR A B TN BEAEN
T 4, & B0 T 10 0 NGB 7 — (1 I U |- 0 26 » G
SRR A W R B i i A ) o

@TER R4 TR I BER IR E WM o

GOFHEHEB I RN B R (KB
MR EEFNBRELABRLE - 5 ¥
BRE ) » BRBPMAYE S ¥ o
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PCS MANU PCS MANU

1345 NORTON UTLITY Vx4 00— ———————————— — — 2YEE 1517 L WINDDW = = e o e e ot o e e e oo s s s e e s s e e 1
1400 HARVARD TOTAL PROJECT MANAGER Il Il—=—— — 4YES 1518 ARTEK ADA—-——————————————————— —— 3
1404 NORTON UTILITY ADVANCED EDITION ——————- 2 15623 DBX3——————— e ——— -—— 4
1405 FOXBASEPLUS ——————————————————- 3JYES 1524 GLM ——————— e — 3
1455 PAGE MAKER (FOR MS. WINDOW Ver.1.03)————— B5YES 15625 CHI WRITER Ver.20-- - ————-—————————— 3YES
1456 DIAGRAM MASTER ——————=====—==———- . BYES 15268 VISIBLECOMPUTER 8088 —\ ————————————— 1
1478 TURB0 C===—c—c—cacace—e——- ——— (4.PCS/MANUAL) 1627 XVIEWB8B V.| ——mmcmcccccccamama——— ]
1479 TURBO PASCAL NUMERICAL METHODS 1530 Xs7TAT - —-———————-——-——-—-—-—-—-———————— 3YES

TOOLBOX = mmmmemam e ——— (3.PCS/MANUAL) 1531 GAUSS Ver.140B - - —————————-—=——————— BYES
1481 EUREKA-————— e e e e (1.PCS/MANUAL)

TURBO PROLOG TOOLBOX === ————— (2.PCS/MANUAL)
1483 CPYAT2PL - —-—————— e e = — — -—= 2 YES
1486 TSP ———— e e e = - (3.PCS/MANUAL)
1489 SUPER KEY Ver 1.1BA-———-———————————— (1.PCS)
1492 dBASE[I . APPLICATION LIBRARY - ———————— 2 YES

1494 MEX-PC——ESSSSLLL . _ ( 1.PCS/MANUAL)
1498 ORCAD e 3 YES®
1499 REALWORLD Ver1.0 (FOR AT XENIX 1.0 ONLY) ——12 YES
1500 VENTURA PUBLISHER ——————————————— — 12 YES
1501 AUTOCAD Ver2 ————————————— - ———— e
1503 QUICKSILVER COMPRER ——————————— ———— b
1504 RAPK P ———————— 3YES
1505 TRUE BASIC TOOLBOX Ver.1.0 ——————————— 10
1508 STATGRAPHICS Ver20 ——————————————— B
1609 STARTERMER . _ e B
1612 SPACE QUEST ———— —(EGA)MONO/COLOR GAME) 2 YES

1516 REFEREER B — . 1YES
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